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Preface

This manual describes the operation of the Data Collection Software, U-50PC.

Be sure to read this manual before using the product to ensure proper and safe operation of
the instrument. Also safely store the manual so it is readily available whenever necessary.
Product specifications and appearance, as well as the contents of this manual are subject to
change without notice.

Licensing

HORIBA Advanced Techno Co., Ltd. agrees that the customers use the software and this
instruction manual provided that the following information is well observed by the customers.

Bl Copyright
HORIBA Advanced Techno Co., Ltd. owns this software copyright.

B Range of licensing

Customer can use the software in a single computer that the customer has and uses it on his
own. The licensing that the customer obtains is nonexclusive rights and shall not be assigned.

B Duplication
Customer can only duplicate the software for his/her own backup purpose. The duplicated

product shall never be used by a third person. Reverse engineering or any other equivalent
action shall be prohibited.

B Warranty and indemnification

* HORIBA Advanced Techno Co., Ltd. shall not be liable for any possible damages resulting from
failure of this software, any erasure of data, or any other uses of this software.

« This software is designed for a connection between one Meter and one PC. Connecting multiple
Meter or using hub network may not always guarantee the performance of this software.

« HORIBA Advanced Techno Co., Ltd. can't compensate even if there are mistakes in this
instruction manual.

« Specification of this software may be modified without any advanced notifications.

Trademarks

Microsoft and Windows are either registered trademarks or trademarks of Microsoft
Corporation in the United States and/or other countries.

Generally, other company names and bland names are either registered trademarks or
trademarks of the respective companies.

Windows is a registered trademark or trademark of Microsoft Corporation in the United States
and other countries.

January, 2019  © 2017 — 2019 HORIBA Advanced Techno Co., Ltd.
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1.1

1.2

1.3

About the software

What this software can do

This software is dedicated for the U-50 Series Multi Water Quality Checker. It can import
measured data into the computer and save it as a csv-formatted file. It can also import meter
memory data.

Symbols/Expressions

® The symbols used in this manual regarding Windows operations and screens are listed
as follows.

[ ]: buttons and menus

< >: Window and dialog box titles
® The U-50 Series Multi Water Quality Checker is expressed as "the meter".
® Explanations of Windows operations are illustrated using Windows 10.

Precautions

Before using the software, please read the following precautions.

® Be aware that this software is not guaranteed to work on all computers.
Only the administrator of the computer can install this software.

This software may not work properly while other applications are running.

It might be different from the example of the screen of this manual according to the
version of the U-50 series.



2 Functions and operating environment

2.1  Functions
The software has two main functions, "importing measured data" and "downloading data".

® Importing measured data

Real time data measured by the meter is imported into the computer and displayed as a
graph. The measured data can also be saved as csv format.

® Downloading data

Data saved in memory on the meter can be imported into the computer. You can also create
a graph and save the data as csv format.

2.2  System configuration
The system configuration diagram is shown below.

e USB Communication
e

Communication cable

/ Computer
/ \
{ bnu!lmi._-d\ !
B B
¢ o oI
o 0 9
o o oi Meter
—
2.3 System components
Meter U-51, U-52, U-52G, U-53, U-53G
Computer See "2.4 Computer specifications"
Communications Option: Part No. 3200174823.
cable Commercial part: A USB cable with a USB A plug and a
USB B plug for both ends.
(Mini plugs and micro plugs cannot be used)




2.4  Computer specifications
Table 1 shows necessary and recommended computer specifications.

Table 1 Computer specification

ltem Necessary specification Recommended specification
CPU 800 MHz or higher 1 GHz or higher
Memory 512 MB or higher 1 GB or higher
Free hard drive | 15 GB or higher 15 GB or higher
space
(O] Windows 7 (32bit), Windows 8 (32bit),
Windows 10 ver.1803 (32bit)"
Display Super VGA (800 x 600) or higher
Connector USB A connector

*. The operation in 64bit Windows is not guaranteed. However, it has been confirmed that
the operation in computers as follows is fine.

-EPSON Endeavor NJ 4000E Windows 10 Enterprise 64bit

Note
This software may not operate correctly if memory or hard drive space is not enough.



Setup

Installation of the software and installation of the driver are necessary to use the software.

3.1 Installation of the software

Note
To install the software, log in as a user with Windows administrator rights.

® |[nstallation

Preparation of executable file
Setup with CD
1. Insert the setup CD into the computer's CD-ROM drive.
2. To start the installation, Right-click and Run [U-50Setup.exe] as administrator.

Setup with downloaded file
1. Decompress the downloaded folder "U50Setup.lzh" and save the file "U50Setup.exe" to
the folder.

2. To start the installation, Right-click and Run [U-50Setup.exe] as administrator.

Start the installation
1. Select your language in <Choose Setup Language>, and click [OK].

U-50 Data Collecting Program - InstallShield Wizard >

Select the language for the installation from the choices below.

English (United States) e

Concel




2. Select "l agree to the license and condition” and click "Install".
ﬁ Microsoft Visual C++ 2013 Redistributable (x86) - 12.0.305... — hod

Microsoft Visual C++ 2013
Redistributable (x86) - 12.0.30501

MICROSOFT SOFTWARE LICENSE TERMS

MICROSOFT VISUAL C++ REDISTRIBUTABLE FOR VISUAL STUDIO
2013

These license terms are an agreement between Microsoft Corporation (or

hacad nn whara wnn livva nna of ite affiliatact and wnn Plaaca rasd tham

| agree to the license terrms and conditions

Install Close

3. <InstallShield Wizard> is displayed, then click [Next >].
U-530 Data Collection Software Setup >

Welcome to the InstallShield Wizard for U-50
Data Collection Software

The InstallShield Wizard will install U-50 Data Collection
Software on your computer. To continue, dick Mext.

Note
Click [< Back] when you wish to return to an operation at any time during the installation.



4. Enter [User Name:] and [Company Name:], then click [Next >].

U-50 Data Collection Software Setup >

Customer Information

Flease enter your information.

Flease enter your name and the name of the company for which yvou work.

User Mame:

| T aro Horiba |

Company Mame:

| HORIEA, Ltd| |

5. Select the [Destination Folder] to be saved this software, and click [Next >].

L-50 Data Collection Software Setup X

Choose Destination Location
Select folder where setup will install files.

w

Setup will install U-50 Data Collection Software in the following folder.

To install to this folder, dick Mext. To install to a different folder, dick Browse and select
another folder,

Destination Folder

C:¥Program Files (x86)¥HORIBA¥U-50Program Browse. ..




6. Enter [Program Folders:] and click [Next >]. "U-50" is recommended to name the folder.
U-50 Data Collection Software Setup

Pt

Setup will add program icons to the Program Folder listed below. You may type a new folder
name, or select one from the existing folders list. Click Next to continue.

Program Folder:
| I |
Existing Folders;

Accessibili

Accessories

Administrative Tools

EPSOM DIRECT
Maintenance

Microsoft Office 2016 W—)|
Microsoft Office Webtr |-

SoftBank 203HW Utility
Startlp

Select Program Folder

Flease select a program folder,

7. Confirm the installation settings and click [Next >].
U-50 Data Cellection Software Setup

Start Copying Files

Review settings before copying files.

Setup has enough information to start copying the program files. If you want to review or

change any settings, dick Badk. If you are satisfied with the settings, dick Next to begin
copying files.

Current Settings:

The folder which this application will be installed:
C:¥Program Files (x86)¥HORIBA¥U-50Program

The group name which is appeared on program item from start menus:
U-50




8. Click [Finish] to complete software installation.

U-30 Data Collection Software Setup

InstallShield Wizard Complete

Setup has finished installing U-50 Data Collection Software on
yaour computer,

< Back Cancel




Connecting the meter and computer, and installing the driver
In order to connect the meter to the computer, the driver must be installed on the computer.

Driver installation setup
1. Decompress the downloaded file “CDM21228_Setup.zip” and save it in the folder.

Cable connection

1. Ensure that the meter's power is turned OFF.
2. Connect the communication cable.

Driver installation
1. Run“CDM21228_Setup.exe” and Click “Extract”.
i@ FTDI CDM Drivers pt

FTDI CDM Drivers

Click '‘Extract’ to unpack version 2.12.06 of FTDI's Windows
driver package and launch the installer.

www ftdichip.com

| Extract | Cancel
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2. Click [Next >].

Device Driver Installation Wizard

Welcome to the Device Driver
Installation Wizard!

This wizard helps you install the software drivers that some
computers devices need in order to work.

To continue, click Mead.

Cancel

(s
[v1]
g
W

3. Select “l accept this agreement” and click [Next >].

Device Driver Installation Wizard

License Agreement

" To continue, accept the following license agreement. To read the entire
% agreement, use the scroll bar or press the Page Down key.

IMPORTANT NOTICE: PLEASE READ CAREFULLY EEFORE ~
INSTALLING THE RELEVANT SOFTWARE:

This licence agreement (Licence)is a legal agreement between you
{Licensee or you) and Future Technology Devices Intemational Limited

of 2 Seaward Place, Centurion Business Park, Glasgow G41 1HH,
Scotland (UK Company Mumber SC136640) (Licensor ar we) for use of
driver software provided by the Licensor(Software).

BY INSTALLING OR USING THIS SOFTWARE YOU AGREE TO THE w

()| accept this agreement Save As Print

()| don't accept this agreement

it Cancel




4. Click [Finish].

Device Driver Installation Wizard

Completing the Device Driver

Installation Wizard

The device driver installation wizard did not update any of your
software for your hardware devices because it was not better than
the software you cumenthy have installed.

Driver Name

w# FTDI COM Driver Packa...
w# FTDI COM Driver Packa...

Status

Ready to use
Ready to use

11



3.3  Setting of port

The port must be set before importing and downloading data.

® Procedure

1. Confirm the COM port communications cable is recognized.

2. Select the port in the software.

® Confirm the computer's port

1. Select [Printers and Other Hardware] on <Control Panel>.

Control Panel

= v P » Control Panel

Adjust your computer’s settings

History
Backup and Restore (Windows 7)
Find and fix problems

My Network and Internet
\ Connect to the Internet
Wiew network status and tasks

./ Hardware and Sound
___ Wiew devices and printers
Add a device

Programs

‘-._‘_'
[‘]‘ Uninstall a program

System and Security
Review your computer's status
Save backup copies of your files with File

Choose hoemegroup and sharing options

Adjust commonly used mobility settings

&5

T

©

e

v Search Control Panel

View by:  Category =

User Accounts
®) Change account type

Appearance and Personalization
Change the theme

Clock, Language, and Region
Add a language

Change input methods

Change date, time, or number formats

Ease of Access
Let Windows suggest settings
Optimize visual display

12




2. Select [Device Manager] under the <Hardware and Sound>.

# Hardware and Seund - O >

« = ~ 4 % » Contrel Panel » Hardware and Sound v O Search Control Panel y=

Control Panel Home . .
Devices and Printers

Add a device | Advanced printer setup | Mouse | MY Device Manager
Change Windows Te Go startup options

4

System and Security
Metwork and Internet

+ Hardware and Sound Auto Pla’)"
Change default settings for media or devices Play CDs or other media automatically
Programs
User Accounts Sound

Adjust system volume | Change system sounds | Manage audio devices
Appearance and
Personalization Power Options

Change battery settings | Change what the power buttons do

Change when the computer sleeps | Adjust screen brightness | Choose a power plan

Clock, Language, and Regicn
Ease of Access

Display

Make text and other items larger or smaller
How to correct monitor flicker (refresh rate)

g €<l

2., Windows Mability Center
Adjust commonly used mobility settings | Adjust settings before giving a presentation

b

i

)

: Infrared
. Send or receive a file

Realtek HD Audio Manager

9

13
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3. Select [Ports (COM & LPT)] on the <Device Manager>. Check the COM number of [USB Serial

Port (COMX)]. Example below shows COM3

as

USB

communications

port.

% Device Manager
File  Action View Help

e« @ HE =

O

X

~ M DESKTOP-B2BAHDEB
i Awudio inputs and outputs
E Batteries
E Computer
= Disk drives
& Display adapters
s DVD/CD-ROM drives
; Firmware
ey Human Interface Devices
== |DE ATA/ATAPI controllers
:|"‘; Imaging devices
Keyboards
@ Mice and other pointing devices
E Modems
[ Menitors
P Metwork adapters

[ Portable Devices

f5 Ports (COM & LPT)

™ Print queues

[ Processors

Security devices

Software devices

Sound, video and game controllers

£ jmm 1m

iﬁ

7 Storage controllers
E3 System devices
i Universal Serial Bus controllers




® Software settings

1. Select [Port] on the [Settings] menu.

U-50 Data Collection Software — O X
File Data Graph Settings Help
File [T 1 Temperature (===
SITE 1.00 ==
DateTime
GPS 090
Temp :
c 0.a0
P H pH
pHmv iy 0.70
ORP
i/ 0.60
Cond mSdcm
il 0.50
Turbidity NTU
Do ma/L 0.40
[u}
DO% y
0,30
TDS ail
SEUIHIT}" ppt 0.z0
5G Sigma t
010
Depth "
— 0.00
00:00:00 00:00:02 00:00:04 00:00:08 00:00.08 00:00:10
el [ other | NS Time -
Unattached | Na. 1 Import meazured data Dovnload data Graph gettings =57 graph Depth graph

2. Select the port number. COML1 is selected in this example.

Port Settings

>

PortHo.

coM3 R4

BaudRate |19200

DataBits |2
Parity | MHone

StopBitz |1

o]

Cancel |

The port number can be selected from COM1 to COM19.

15



3.4

Uninstall the Software

1. Display the <Control Panel> and select [Uninstall the program].

Control Panel

S5 v A » Control Panel

|Search Control Panel

v 0

View by:  Category ~

Adjust your computer’s settings

System and Security

Review your computer's status

Save backup copies of your files with File History
Backup and Restore (Windows 7)

Find and fix problems

User Accounts
®) Change account type

Change the theme
Network and Internet

Connect to the Internet
Add a language

Change input methods

View network status and tasks
Choose homegroup and sharing options

Change date, time, or number formats

/ Hardware and Sound

View devices and printers

Add a device

Adjust commonly used mobility settings

Ease of Access
Let Windows suggest settings
Optimize visual display

Programs

Uninstall a program

Clock, Language, and Region

Appearance and Personalization

16

2. Select [U-50 Data Collection Software] from the [Uninstall and Change a Program] list in <

Program and Features>, then click [Change/Remove].

B Programs and Features

&« v 4 E » Control Panel » Programs * Programs and Features

Control Panel Home .
Uninstall or change a program

View installed updates

®) Turn Windows features on or

off

Organize *  Uninstall Change

-

MName Publisher
A& Intel @ Serial 10
) Microsoft Office Home and Business 2016 - ja-jp

‘ﬁMicrosof‘t‘u‘isual C++ 2013 Redistributable (x86) - 12.0...

Intel Corporation
Microsoft Corporation
Microsoft Corporation

ﬁlNetwnrkDetective Ultra-X

ﬁlPCInspectorﬁd Ultra-X

Blrcpmiusit EPSON DIRECT CORPORATION
ﬁPHotke}r Pegatron Corporation

&'& Realtek Card Reader

4 Realtek Ethernet Controller Driver

34 Realtek High Definition Audic Driver
= SoftBank 203HW Utility

Realtek Semiconduct Corp.
Realtek

Realtek Semiconductor Corp.
Huawei Technologies Co., Ltd

[#5] U-50 Data Collection Software HORIBA, Ltd.
TeEmEEET I - EPSON DIRECT
[ ) Ty Ty Ty — L Metlapan, Inc.

<

HORIBA,Ltd. Product version:
Help link:

1.0.1.8
http://www.horiba.com

To uninstall a program, select it from the list and then click Uninstall, Change, or Repair.

v 0

Installed On
11/10/2017
10/19/2018
11/10/2017
5/15/2017
5/15/2017
5/15/2017
5/15/2017
5/15/2017
5/15/2017
5/15/2017
10/19/2018
10/19/2018
5/15/2017
5/15/2017

Support link:  http://www.horiba.com

- O X

Search Programs and Features 0@

Size

612 KB
955 MB
17.1 MB
132 MB
210 MB

586 KB
323 MB
15.2 MB
3.61 MB
43.6 MB

1.42 MB
154 MB

Version
30.100.1519.7
16.0.7571.2122
12.0.30501.0
1.00.0000
26415132

3.01

1.00.0127
10.0.10586.31225
10.2.703.2015
6.0.1.7730
23.009.09.26.643
1.0.1.8

23.00

72




3. Click [OK] in <Confirm Uninstall>.

U-50 Data Collection Software Setup

Do you want to completely remove the selected application and all of its features?

Yes Mo

4. Cl

ick [Finish] to complete software uninstallation.

L-50 Data Cellection Software Setup

Uninstall Complete

Installshield Wizard has finished uninstalling U-50 Data
Collection Software.

@ Yes, I want to restart my computer now.
(Mo, I will restart my computer |ater,

Remave any disks from their drives, and then dick Finish to
complete setup.

< Back Cancel

17



3.5 Language

Depending on your operating system, this software switches to Japanese or English
automatically. In case of trouble that language doesn't switch automatically, check the setting
of your computer as follows.

1. Display the <control panel> and select [Clock Language, and Region]

e_ 'f-_;_\' @ ¥ Control Panel »

rch Control Panel e
Adjust your computer's settings View by: Category =

User Accounts and Family Safety

'@ Add or remaove user accounts

[\e] System and Security
4.3 Review your computer's status
4 Back up your computer

Find and fix problems

Network and Internet
@h Connect to the Internet
&2,  View network status and tasks
Choose homegroup and sharing options

'@' Set up parental controls for any user

Appearance and Personalization
Change the theme

Change desktop background

Adjust screen resolution

Clock, Language, and Region

/ Hardware and Sound ]
Change keyboards or other input methods

3%‘ View devices and printers
Add a device

Connect to a projector
Adjust commonly used mobility settings

% Programs
h‘ | Uninstall a program

XA

Ease of Access
Let Windows suggest settings
Optimize visual display

18



2. Select <Change keyboards or other input methods>.

',(-\' ‘ 3 + Control Panel » Clock, Language, and Region - Search Control Panel el

Control Panel Home

Date and Time
Set the time and date | Changethetimezone | Add clocks for different time zones
Add the Clock gadget to the desktop

System and Security

MNetwork and Internet
Hardware and Sound 9 Reglon and Language .
Change location | Change the date, time, or number format
Programs Change keyboards or other input metheds
User Accounts and Family
Safety

Appearance and
Personalization

® Clock, Language, and Region

Ease of Access

19
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3. Confirm that Format is <English (United States) >.

Region and Language "

Formats | Location | Keyboards and Languages | Mministlati'u'el

Eormat:

[English (United States)

Date and time formats

Short date: ’Wdfmj,r v]
Long date: | dddd, MMMM dd, yyyy -|
Short time: ’h:mmtt ']
Leng time: ’h:mm:sstt v]
First day of week: ’5unday v]
What does the notation mean?
Exarnples
Short date: 12/11/2018
Long date: Tuesday, Decernber 11, 2018
Short time: 351 PM
Long time: 3:51:26 PM
| Additional settings...
Go online to learn about changing languages and regional formats
| ok || cancel Apply




4.1

Start-up and exit

Start up

Select [All Programs] - [U-50] - [U-50 Data Collection Software] from [Start] menu, and main

window opens.

[#] U-50 Data Collection Software
File Data Graph Settings Help
File
SITE
DateTime
GPS
Temp @
pH pH
pHmY i
ORP oy
Cond mS/om
Turbidity NTU
Lo ma/l
DO% %
TDS ol
Salinity a0
SG Sigma t
Depth o
Calib, Other NGRS
Unattached | Mo, 1

[cl 1: Temperature

uuaﬂ

0.70

0.60

0.50

0.40

0.30

0.20

0.10

0.00
00:00:00 00:00:02 00:00:04

00:00:08

Time

00:00:08

00:00:10

Import measured data Download data

Graph settings

X graph

Depth graph ‘

21



4.2  Exit

Select [Exit] from [File] menu or click the [Close] button in the upper-right of the window.
During importing measured data, the software cannot be closed. Stop importing to close the
software. (See "5 Importing measured data.")

[Close] button

|

U-50 Data Collection Software = a x
File Data Graph Settings Help
Open | ['Cl 1: Temperature: Di‘
. [ 1.00,
Save
bt 0.40)
Temp - -
pH oH
pHmY b 070
CRP . -
Cond mS/em
Turbidity WU Gl
e ma/l 0.40)
DO% o
0.30)
TDS al
Salinity ot 020
SG Sigma t
010)
Depth -
; ‘toocon 002 a0 04 0005 00008 000010
[FEEIEN [ Other  |NNEEEN | Timer =

Unattached | Mo T4|» Import measured data Dowrload data Graph settings ¥ araph I Depth araph J

22



4.3 Main window

On the main window, you can select functions of "Import measured data” or "Download data",
and settings of port or graph.

DMenu bar @Data information @Measured data
[#] u-350 Data Cpllection Software - O X
e Data Graph Settings Help
Fi [t 1 Temperature Dﬂ
SiTe m a0,
steTime 20181019 16:13:41 26.00)
[5 o e %,
To 20" . 4,00

’ )
,TD El s 151332 151335 151338 TEE0
pHmMY ,— i -
[oH] e -
ORP ’—1 i 478
Cond 0.000 .s/en 475
Tubidty [ o

[=>]

—
'S
w

(=]
-~

Do 00 e ||\,

D024 o 161329 16:13:32 161335 16:13:33 16:13:41
Time

TDS 0.000 all ] 3: pHmy m="=]l

Salinity 00 - 14
G 0.0 e

Dept

148

m

)

145 s

1671323 187 161335 A2 181341
e > EEI | Ot ; =
EOrattached ) @t romdern ||| B @ Gapl’\ seflings | % graph \ @
r'y

Iy

I |
(©Communications | @Measurement AT \L
ndicator status ®Import measured @Graph
@Meter error ~ @Data No. date/Download data

4.3.1 Menu bar

® [File] menu
You can select [Open] to open a file, [Save] to save data, or [Exit] to exit the software.

U-50 Data Collect
File Data Graph
Open

Save

23



24

® [Data] menu

You can select [Import measured data], [Stop importing], [Download data], [Select data], or
[Clear].

1-50 Data Collection Software
Data Graph Settings Help

Import measured data

Stop importing
Download data
Select data

Clear

® [Graph] menu

You can select [Disp humbers] to select the number of graphs displayed, [Settings] for graph
settings, [Depth graph] to create a depth graph, or [X-Y graph] to create an X-Y graph.

U-50 Data Collection Software
File Data Graph Settings Help

File Dizp numbers o]

SITE Settings 2

DateTime Depth graph 3
GPS

#-Y graph ’

® [Settings] menu
You can select [Port] to port settings or [Import cycle] to import cycle setting.
U-50 Data Collection Software

File Data Graph | Settings Help

File Port
SITE Import cycle

® [Help] menu
You can select [About] to display version information.
U-50 Data Collection Software
File Data Graph Settings Help
File: About



4.3.2

Data information

File datal.cav
SITE HORIBA
DateTime 2008/08/07 19.37:56
GPS J45863M /135 4326E
® <File>
File name is displayed when measured data is saved or opened.
® <SITE>
Set SITE is displayed.
® <Date Time>
Date and time are displayed when data was acquired.
® <GPS>
GPS data is displayed.
* GPS data is added to the data when acquired with the U-52G or U-53G.
4.3.3 Measured data
® Measured data
Temp | 24.83 ¢
pH 6.99
pHmY 0.
ORP 992 .
Cond '4 49 S 4o
Turbidity 12.0 um
DO 4.54 0
DO% 56.3 4
TDS 2.87 o
Salinity 1.7 oo
SG D D Sigma t
Depth 7.55,
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4.3.4 Meter error
This field turns in red in case of meter.

W arning

Meter error occurs ->

Identified meter errors

® Probe ADC error

Probe EEPROM error/Factory
Probe EEPROM error/User
Display unit RTC error
Display unit FROM error
Turbidity lamp error
Turbidity wiper motor error
Probe Capacitor error
Probe EEPROM error
Display unit data store error
Probe PC board defect

Reference
See U-50 series instruction manual to check errors.

4.3.5 Communication confirmation
Communication status is displayed.

IInattached

: displayed when communication was failed.

Imparting

: displayed when measured data was imported.

4]

Connect

: displayed during data downloading.
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4.3.6 Measurement status

When measured data is in the state of <Calib.>, <Other>, or <Error>, data field of the color
changes corresponding to the status.

[ Calbe || oter  [ERSH

<Calib.>: Under calibration.

6.99 .+

<Other>: Under measurement or hold.

0.00 ymy

<Error>: Error data was measured.

T

4.3.7 Data No.

Data No. is added in the order of acquisition of data. By selecting the number, the numbered
data is displayed. You can go to forward and afterward data by pressing right/left keys.

Mo 65 ﬂ ﬂ

4.3.8 Importing measured data/download data

® [Import measured data] [Stop importing]

You can start or stop importing measured data. [Import measured data] is shown when
measured data are not imported, and [Stop importing] are shown when measured data are
imported. (See "5 Importing measured data.”)

Import measured data Stap importing

® [Download data]
You can download data from the meter. (See "6 Download.")

Download data

27



4.3.9
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Graph

Graph of imported data or downloaded data are displayed. The horizontal axis represents
time, and the vertical axis represents the measured values for each parameter. 1 to 3 graphs
can be displayed simultaneously. Parameters can be changed with the scrollbar on the right
side.

['C] 1: Temperature Oogg~
24.80 e
Scrollbar
24.79
I 50 100 150 200 250 300
Time [zecond]
[pH] 2:pH ==
7.02
7.0
7.00
1] 50 100 150 200 250 300
Time [zecond]
[mi] 3 pHm D
1
0
-1
I 50 100 150 200 250 300
Time [zecond] -

Download data

=41 graph ‘ Depth graph

Import meazured data Graph zettings

[Graph settings]
You can set the graph style. (See "8.1.3 Graph settings.")

Graph zettings

[X-Y graph]
You can create a X-Y graph. (See "8.2 X-Y graph.")
#-1 araph

i

[Depth graph]
You can create a graph with depth as the axis. (See "8.3 Depth graph (U-52G, U-53,
U-53G)")Depth graph.")

Depth graph

* Available for U-52G, U-53, U-53G.



4.3.10

Menu bar tree and shortcut button

Action

Menu bar tree

Shortcut Button

To start importing measured
data.

[Data] - [Import measured data]

Import meazured data

To stop importing measured

[Data] - [Stop importing]

data Stop imparting

To download memory data. | [Data]- Dowrload data ‘
[Download data]

To change the number of | [Graph]-

graphs.

[Disp numbers] - [1 (or 2, 3)]

To set the graph.

[Graph] - [Settings]

araph settings

To draw a depth graph.

[Graph] - [Depth graph]

Depth araph

To draw an X-Y graph.

[Graph] - [X-Y graph]

#- araph

29



5 Importing measured data

Measured data can be imported using “import measured data” function. Data is shown in
graph and saved as csv format.
See "8 Graph" For graphs, "7.1 Saving file" for saving data.

Note
* To import measured data, the meter's display unit and sensor probe must be connected and
the measurement screen are displayed.
- 10000 data or less can be imported.

5.1  Setting of cycle (time interval) of data import
Time interval of measured data can be set.

1. Select [Import cycle] on the [Settings] menu.
L-50 Data Cellection Software
File Data Graph @ Settings Help
File Port
SITE Import cycle

2. Enter time interval between 1 and 9999 seconds, and click [OK].

Import cycle X

Impart cycle |1 zeC.

QK. | Cancel |

Note
If O (zero) second was set, error windows are shown.

U-50 Data Collection Software

[9} Out of range
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5.2 Importing measured data

1. Select [Import measured data] on the [Data] menu.

You can also import with the [Import measured data] button in the lower portion of the

main window.

|mport measured data

2. The confirmation screen is displayed. Click [OK] to start importing. .

U-50 Data Collection Software

b Start importing.

o]

_,-'I The data in the PC display is overwritten.

Cancel

*

5.3  Stop importing

1. To import data, click [Stop importing] on the [Data] menu.
You can also stop importing with the [Stop importing] button.

Stop importing

2. The confirmation screen is displayed. Click [OK] to stop importing.

U-50 Data Collection Software

0K | Cancel

X
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Download

Saved data in meter can be downloaded, and graph can be drawn. Data can be saved as csv

format.

See "8 Graph" For graphs, "7.1 Saving file" for saving data.

1. Select [Download data] on the [Data] menu.

You can also download data with the [Download data] button.

Dovwnload data

2. A confirmation screen is displayed. Click [OK] to download.

U-50 Data Collection Software *

If there is downloaded data, window below is displayed. To download data from the

meter again, select [Yes].

U-50 Data Collection Software

|"/ A There are same data in memory.

YES:Download from the controller.,
MNO:Use the downloading data.

Y Download the data from the controller again?

Cancel

*

3. The screen below is displayed during download. Wait until the download completes.

MNow downloading

93/138

Cahicel




4. The <Data selection> window appears. Select the data to download and click [Download
selected data]. Selected data are displayed in blue. In this example, No. 1 through 5 are

selected.
Data selection O et
Mo D ate SITE Latitude Longitude A
' I T T
I E T T
[ 2 2129 345359H 135 4325E
7 20070114 01:23:29 34 5359H 13543 25E
a 20070114 01:23:39 34 5389H 13543 25E
3 20070114 01:23:49 345359H 13542 25E
10 200740114 01:23:59 345359H 135 4325E
11 200740114 01:24:09 34 5359H 13543 25E
12 20070114 01:24.19 45309 H 13543 25E N
Dezelect Al zelect Delete selected data Download selected data Cloze
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Saving and opening files

7.1  Saving file

You can save imported data with the software as csv format.
1. Select [Save] on the [File] menu.
2. Select the folder to save to with the <Save As> dialog, and enter a file name and save.

Save As
= v P » This PC » Desktop » data v | 0 Search data
Crganize « Mew folder T v

Mo items rmatch your search.

File name: |

Save as type: | csv files(*csv)

» Hide Folders Cancel

34




7.2

Open file

You can load data saved.
1. Select [Open] on the [File] menu.

2. Select the file saved with the <Open> dialog.

Cpen

y i » This PC » Desktop » data

Organize - MNew folder

@data'l

v O

Search data

File name: | datal

i | csv files(Fosv)

Note
* You can only open csv files saved.

* Files opened by other programs cannot be opened with this software. The error message

below is displayed.
U-50 Data Collection Software %
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7.3  Format of csv file
Files saved with this software are made up of the data below.

Column Data Explanation

1 No. Data Number

2 SITE SITE

3 Date Date and time the data was acquired
When importing measured data: acquired from the

2 Time computer's clock_ '
When downloading data: acquired from the meter's
clock

5 Latitude Latitude acquired with GPS

6 Longitude Longitude acquired with GPS

7 Probe error Meter error
For error details, see instruction manual of the
meter.

8 Temperature Value Temp value

9 Unit Temp unit

10 Error Temp error information

11 pH Value pH value

12 Unit pH unit

13 Error pH error information

14 pHmMV Value pHmMV value

15 Unit pHmMV unit

16 Error pHmMV error information

17 ORP Value ORP value

18 Unit ORP unit

19 Error ORP error information

20 Conductivity Value Cond value

21 Unit Cond unit

22 Error Cond error information

23 Turbidity Value Turb value

24 Unit Turb unit

25 Error Turb error information

26 Dissolved Value DO (mg/L) value

27 Oxygen Unit DO (mg/L) unit

28 (mg/L) Error DO (mg/L) error information

29 Dissolved Value DO (%) value

30 Oxygen Unit DO (%) unit

31 (%) Error DO (%) error information

32 TDS Value TDS value

33 Unit TDS unit

34 Error TDS error information

35 Salinity Value Salinity value

36 Unit Salinity unit

37 Error Salinity error information

38 Specific gravity | Value SG value

39 Unit SG unit

40 Error SG error information

41 Depth Value Depth value

42 Unit Depth unit

43 Error Depth error information

44-54 Information to open the file with the software.
Note

The title, csv file version, and amount of data is saved in the first line.
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8 Graph

A graph of imported data or downloaded data is displayed in the main window. You can set
the graph type and create an X-Y graph and depth graph.

8.1 Main window graph

8.1.1 Cursor

A red cursor indicates the position of measured data displayed on the left side. If you forward
data No., the cursor moves.

U-50 Data Collection Software - O X
File Dsta Graph Settings Help
Fle | 20171122_U-50 test HORIBA. cov Il 1+ Temperature Ubﬂﬂj
SITE HORIBA i
DateTime 2017711722 154338
GPS 345853N /13543 26 F 2900
Temp | 23.28 s
pH 0.00 ,,
pHmY 402 ., 2m
Rk 186 260
Cond 0000 mSdcm
Turbidity 298wy 2o
oo 10.14 .1 —-—
po% | 11885
5 [ 0000, | =
Salinity 0.00 . o
5G 0.0 signat
Depth . By
= 2000
154329 183 15:43:41 15:43:47 15:4353
Time -
Unat Impart meastred data Download data Graph seltings %Y gaph | Depthgraph

Data No. Red cursor
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8.1.2
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Setting of the number of graphs displayed

You can select the number of graphs to display in the main window from 1 to 3 graphs. The
selection can be made from [Disp numbers] on the [Graph] menu. The selection can also be
made from the icons displayed in the upper-right of the graph. From the left, the icons
represent 1, 2, and 3 graphs to display. Example snows 3 graphs.

[®] u-50 Data Collection Software - o X
File Data Graph Settings Help
File 20171122_U-50 test HORIBA, csv I'cl 1: Temperature ( Oe8 ﬁ
SITE HORIBA auod |
DateTime 2017/11/2215:43:35
GPS 345859 /135 43 26E 2300
Temp | 23.28. .
pH 0.00 '
pHmMV 402 . 27.00
i 186 1/ 2600
Cond 0.000 ,,5/cm
Turbidity 298 wru 25.00
Do 10.14 . i
DO% 118.8 .
s [ 0000, | 2®
Salinity 0.00 ,,, 2200
SG 00 Sigma t
pepth [, ZL
N 2[}%‘3&29 16:43:35 15:43:41 15:43:47 15:4353
: TEE [ Oter - - ~ Time o o v
Unattached | No. T4|» Impoit measured data Download data Graph settings # giaph Depth graph

N

OBEE



8.1.3 Graph settings

Select [Settings] on the [Graph] menu to display the settings window. The settings window
can also be displayed with the [Graph settings] button in the lower-right of the main window.

Graph settingz

Parameter, Unit Display range settings

Graph settings l

Paramsin
) | Tempershae = [-c

12 [ =] [wi
13 [ = [
141 [oRF ] [mv

19 [Conduairty =] [mSfem

1% | Taticiey =) [wtu
171 [Disoved Dargen =] [mgit
14 [pox = [=
14 [ros =] far
1104 [Saleuty =l [ot
[11) [Spaciic gty =] [Sicrmar
1124 Drepith =] [m

Time axis settings

Note
The range cannot be directly entered when [Auto] is checked.
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® Parameter, unit

The parameter and unit can be selected.
Farameter

| Temperature ﬂ

- Temperature
pH

pHmY

ORP
Conductivity
Turbidity
Dizzolved Dxyaen ]
Do It
TDS

Salinity
Specific gravity
Depth

Display range settings
You can set the range of vertical axis of the graph.

If [Auto] is checked, the range is automatically determined from the data.
Dizplay range settings

If [Auto] is unchecked, the upper and lower limit values can be entered. In this example the
lower limit is 20, the upper limit is 30.

Dizplay range settings

g |20 T

Time axis settings
You can set the time axis of the graph.

1. Select the display format.
Calculated time: Displays the time axis as the elapsed time from the oldest data.
Direct time: Displays the time axis as the time the data was acquired.
Time awxiz settings

| Calculated time ﬂ

Calculated tirme
Direct time

2. Set the range of the horizontal axis of the graph.
If [Auto] is checked, the range is automatically determined from the data.

* Auto  Manual " In the previous data

| zecond zecond




8.2

If [Manual] is checked, the upper and lower limit values can be entered. In this example the
lower limit is O, the upper limit is 10. The unit is seconds.

O Auto & Manual " |n the previous data

gecond gecond

|n - |1n

If [In the previous data] is checked, the graph is displayed with data going back from the
newest until the entered time.

£ Aute  Manual

| ’ | el | 00 second

Cursor display

If [Cursor display] is checked, the cursor is displayed. When unchecked, the cursor is not
displayed.

[v Cursor display

X-Y graph

You can set one parameter as the horizontal axis and check the correlation with other
parameters.

X-Y graph

File

X axis

<1 1

pH
pHm
ORP
Cond
Turbidity
Do
DOz
DS
Salinity
SG
Depth

LTTTTTTT11]e
<1 %] <1 <1 <1 <] <] <] <] «

9

' axis Scale

|pH

Graph zettings

O

pH [pH]

700

£.35

£.93

10.00

15.00

20.00

25.00
Temperature ["C]

30.00

35.00

40.00
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8.2.1

8.2.2

42

Displaying the X-Y graph

Click [X-Y graph] on the lower-right of the main window to display the <X-Y graph> window.
You can also display the X-Y graph with [X-Y graph] on the [Graph] menu.

= araph

X-Y graph explanation
You can select a single parameter for the X axis (horizontal axis).

X awiz

Temperature
pH

pHni

OrRP
Conductivity
Turbidity
Dizzolved Oxpgen
DO%

TDS

S alinity
Specific gravity
Diepth

For the Y axis (vertical axis), you can select parameters other than the parameter selected
with the X axis. Temperature is selected for the X axis in this example. Graphs are displayed
with each parameter color-coded.

Y awis

<1

pH
pHm
ORP
Cond
Turbidity
Do
DO
DS

S alinity
SG
Depth

HEREERNEEN
<1 < <1 < < <1 < %] <] «

3

The scale of the vertical axis is displayed as the scale of the parameter selected with [Y axis
Scale].

For the other parameters, they are displayed in the scale set with [Graph settings], but the
scale is not displayed.

' axis Scale




8.2.3 Graph settings

You can set the graph by clicking [Graph settings] in the lower-left of the <X-Y graph>
window.

[araph =ettingz |

See "8.1.3 Graph settings” for how to configure settings.

Graph settings — X
Parameter Uit Display range seftings
[1] |Temperature | |°C | T auwe famo0 . [3000
[2] |pH | |eH | ¥ Aue 000 - [10.00
[3] |pHrmv x| mv | ¥ ue |0 - Jio
[4] |ORP | v | ¥ aue |0 - 1o
[5] [Conductiviy  w| [mSsem  w| M Awe [0000 . |10.000
[E] | Turbidity ~| [nTu o] W oAue f000 - [inoe
[7] [Dissolved Ompgen +| [moll = M Auwo  [0.00 . [10.00
[8] [pO% EIRE | ¥ o |00 - |00
[9] |TDS | for | P auwe [poo0 . [10.000
(10 | Salinity | fewt ~| ¥ Auo |00 . [1oo
[11] [Specific aravity =] [Sigmat v| ™ Auwo |00 - [100
[12] | Depth x| |m | ¥ aue  |0.00 - [1oao
[13] |- | | | VAt |n i |1u
Time axis settings
[Directtine =] ¢ Auto © Manual * I the previous data
ok | [ cancel | seply |
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8.3  Depth graph (U-52G, U-53, U-53G)
With the depth graph, you can check the correlation between measured values and depth.
Depth graph — X
File
o [Termperone RN =l Depth Unit ~ |m ~]
19j1E| Depth 1
1969
20.26 o | .
2087 Ly ]
2146 2
22.05 3
2264 4
2323 5
2382 i
2441 7
25.00 8
2554 4
2618 10
26,77 11
12
1 Measurement data 13
14
15
16
17
18
19
70
21
22
23
24
75
26
27
28
Add Delete | 29
8.3.1 Displaying the depth graph

44

Click [Depth graph] on the lower-right of the main window to display the <Depth graph>
window. You can also display the depth graph with [Depth graph] on the [Graph] menu.

Depth araph



8.3.2

Depth graph explanation

Select the parameter that you wish to check the correlation of to depth.

| Temperature j

Temperature

Conductivity
Turbidity
Digzokved Dupgen
Do%

TDS

Salinity

Specific gravity

+ Select units of parameter and depth.

Depth it m -

The colored relationship with the selected parameter data is displayed.

11.36
1310
14.54
16.58
18.32
20.06
21.80
2354
20.28
2102
28.76
2050
32.24
33.98
3672
3746
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The correlation between the selected parameter and the depth is displayed in color. The
value displayed in the depth indicates the upper end of the range. In other words, depth 0 is O
to 1 m, depth 29 is 29 to 30 m.

Depth 1
L .
2 | oem
3
4 [ |
5 | eem
[
7 [ |
g
g
10
11
12
13
14
15
16
17
15
19 | .
0|
21
72 | .
23
24
E
€ | o
77
7q | .
2 |




8.3.3 Add/delete data

You can add data to the graph by clicking [Add] on the lower-left of the <Depth graph>
window and selecting a csv-formatted file saved with the software.

1. Click [Add].

2. Select a file and click [Open].

[ open d
= v » ThisPC » Desktop » data v | @ Search data R
Organize - MNew folder Er [ @
B datal
f:|data2
B data3
f:|datad

Filename:| v| cav files(*csv) w
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The data is added.

Depth graph
File
1520
T [T -
AL
1956 Deph 1 2
o 0
LT 1 L
2057 . 2 -
3130 ]
IR T
¥R 5 -
LY 5
BT P 7 =
FEL g -
pEET
L] 10| .-
M 1 -
12
Tdatadcav 1% | .
2datad csv 14 [l ]
15
= =
7 ==
18
= -
20 g
il [
2
g —
% |
3; ——
Add Delete 29 == -

]
]

Drepth Lini |rn '-]

Clicking [Delete] to delete the data.

Delete |




9 Troubleshooting

In case of troubles while using the software, first check the items listed below. If the problem

is not resolved after performing these procedures, please contact to your local agency.

9.1 Checklist
Problem Check here Try this Reference
You cannot Free hard drive space is | Ensure enough free space. 2.4 (p. 3)
install the not sufficient.
software.
You cannotrun | The install was not | Reinstall the software. 3.1(p4)
the software. finished correctly.
Free hard drive space is | Ensure enough free space. 2.4 (p. 3)
not sufficient
The communication | Replace the communication
cable is broken. cable.
You cannot The connected port and | Verify the connected port and | 3.3 (p 12)
measure. set port are not the | setit correctly.
same.
The meter is not turned | Check the battery level, cycle | U-50 series
ON. the meter's power. Instruction manual
The display unit and | Connect the display unit and | U-50 series
sensor probe are not | sensor probe. Instruction manual
connected.
The cable is broken. Replace the cable.
Communication is | Restart the computer and
blocked by noise. meter, and start up the software
again.
You cannot The connected port and | Verify the connected port and | 3.3 (p 12)
download. set port are not the | setit correctly.
same.
The meter is not turned | Check the battery level, cycle | U-50 series
ON. the meter's power. Instruction manual
The cable is broken. Replace the cable.
Communication is | Restart the computer and
blocked by noise. meter, and start up the software
again.
9.2 To contact your local agency

When you want to contact your local agency, check the items below in advance.

+ Date/time the problem occurred

» Specify the problem

* Model of the meter used
» Computer specification (CPU, memory, free hard drive space, OS)
+ Software version

* Other questions, requests
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® Checking the version
You can check the version information by selecting [About] on the [Help] menu.

About U-30 Data Collection Software >

I1-50 D ata Collection Software

Copyright 2007-2015 HORIBA, Lid. All rights resered.

Yersion 1.0.1.8 P-Ho. F20004340010
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